Outlook 2007/2010 - Calendar

Best Practices, Do’s, Don’ts, and Tips
# Table of Contents

Introduction ............................................................................................................................ 1  
Outlook meeting requests: Essential Do’s and Don’ts ............................................................ 1  
Best practices – Working with Outlook Calendar ................................................................. 2  
  - Be on the same application version ............................................................................ 2  
  - Limit the number of delegates who have access to your calendar .............................. 2  
  - Schedule end dates on recurring meetings ................................................................. 3  
  - Refresh Data .............................................................................................................. 3  
  - Using Majordomo Lists .............................................................................................. 3  
How Calendar information may be removed or become inaccurate ..................................... 8  
  - Forwarded meetings can lead to inaccurate information in the calendar ............... 8  
  - Send Update when changing a meeting as the meeting organizer ............................. 8  
  - Process a meeting request in the Inbox ..................................................................... 9  
  - Use “Remove from Calendar” .................................................................................. 9  
  - Personal notes are lost after a meeting update is received ......................................... 9  
Tips for power users .............................................................................................................. 9  
  - Let Outlook fill in your date for you ......................................................................... 9  
  - Display a second time zone in your calendar ............................................................. 10  
  - Date in the future? Stop browsing and just GO THERE ............................................ 10  
Mobile Device Tips .............................................................................................................. 11  
Training and Support .......................................................................................................... 11  
  - IT Training .............................................................................................................. 11  
Need Help? ......................................................................................................................... 11
INTRODUCTION

Microsoft Outlook is a powerful calendaring and scheduling tool. This document covers best practices, do’s and don’ts and tips when utilizing outlook calendar functions to avoid problems and work optimally.

OUTLOOK MEETING REQUESTS: ESSENTIAL DO’S AND DON’TS

1. **Make a choice** – When a meeting request shows in your Inbox make a choice right away for each request by selecting either Accept, Tentative or Decline. By making a choice, you keep the meeting organizer apprised of your decision and you prevent the meetings that you want to attend from being accidentally deleted. If you need to attend a meeting but can't at the time it is scheduled, you can propose a new time for the meeting. Try not to delete a meeting request outright because this is one way that meetings get "lost."

   **NOTE:** When viewing or responding from a smartphone - Some smart phones may experience calendaring issues when accepting invites. To avoid any potential issue, it is recommended that you accept invites from your inbox on your computer.

2. **Process meeting requests in order** in which they come into the inbox (oldest first). If you do not process meeting requests that are related to the same meeting in the order that they are received, you may not receive any updates to the meeting.

3. **Keep meetings from vanishing** - If you run Outlook on two computers or a mobile device and accept a meeting while using one of them, don't delete the meeting request from the Inbox on the other computer. If the request is still there, accept it again. Deleting a request on one computer/device after accepting it on another computer/device can cause the meeting to disappear from your calendar.

4. **Process meeting requests and updates from the Inbox** - *Always* accept or decline a meeting request from your Inbox. Yes, Outlook allows you to accept or decline a meeting from its time slot on your calendar, but that can leave the meeting request in your Inbox. If you delete the request from your Inbox it could cause the meeting to disappear. Also, leaving the meeting request in your Inbox might confuse you later and definitely leaves any delegates you appointed wondering about whether the meeting was accepted.

   Soon after a meeting request arrives in your Inbox, a piece of Outlook code - nicknamed the "sniffer" - automatically adds the meeting to your calendar and marks it as tentative. This is a fail-safe to keep you from missing the meeting in case you don't see the request in your Inbox. However, the sniffer doesn't reply to the meeting organizer. You still need to do that by accepting, accepting as tentative, or declining the request.

   **NOTE:** **Mobile Device users:** There are some bugs when accepting a meeting from some mobile devices. The meetings are not synching consistently. It is recommended when possible to respond to meeting invites from your inbox on your computer.
5. **Send updates** - After modifying one of your own meeting requests, remember to click the **Send Update** button to send the updated request to all recipients.

- **Cancel a single meeting** - Need to cancel a meeting? Notify the people you invited by deleting the meeting from your calendar, select **Send cancellation and delete meeting**, and then send the cancellation to everyone you invited.

- **Cancel recurring meeting** - If you, as the meeting organizer, are ending a recurring series of meetings, open the meeting on your calendar, set a new end date, and then send an update. This keeps the past meetings on everyone’s calendars, but future occurrences after the end date are removed.

- **Change meeting organizers** - If a recurring meeting is changing to a new organizer, there is no way to reassign the ownership of the meeting. The original organizer should send an update with a new end date - the past meetings remain on everyone’s calendars, but future occurrences after the end date are removed. The new meeting organizer should send a new meeting invite for meetings in the future.

- **Don’t move meeting requests** - Don’t move a meeting request from your Inbox to a different folder before you accept or decline the request or before the meeting appears in your calendar.

### BEST PRACTICES – WORKING WITH OUTLOOK CALENDAR

#### Be on the same application version

While it seems that there is not a whole lot of difference sometimes between application versions, it does make a difference in avoiding problems when delegates are on a different application version than the owner or you use two different computers/devices with different versions. It is recommended that owners and delegates be on the same version of the application and if you use more than one computer (work vs. home) or device, be sure that both are using the same application version.

#### Limit the number of delegates who have access to your calendar

Outlook does not have a defined limit for the number of delegates that you can add to your mailbox. Although Outlook does not have a defined limit for delegates, other resource limitations will eventually limit the number of delegates you can add to your mailbox. When you reach this limit, you receive the following error message when trying to add a new delegate:

**Unable to forward meeting-related messages**

To prevent incorrect or missing meeting information, it is recommended that you use minimal delegates with Editor permissions if not just one. Decide whether the delegate or the mailbox owner will process all the meeting requests.

If more than one user must have access to your mailbox, carefully consider whether these users
have to be delegates. You may want to give the user Review permissions to your folder instead. To give user Reviewer permissions, follow these steps:

1. Right-click the Calendar folder and then select Properties.
2. Select the Permissions tab.
3. Select Add.
4. Select the name of the user who you want to give Reviewer permissions to and select Add. Next, select OK.
5. In the Name box, select the user name and then select the appropriate permission level using the dropdown menu in the Permission Level box.
6. Select the Apply button, then OK.

**Schedule end dates on recurring meetings**

When scheduling recurring meetings, it is highly recommended that a definite end date be used. If a meeting recurs weekly or monthly over 6 months or a year, it is recommended to make the recurrence end date at 3 or 6 months. When a definite end date is used you may prevent issues that may occur if you have to update the meeting several times. When a recurring meeting must be modified often, changing the recurrence end date after the fact can cause those “exceptions” or modifications to be lost.

**NOTE:** Outlook allows a total of 123 revisions to a recurring meeting, so keep recurring meetings limited to 3 – 6 months maximum.

**Refresh Data**

It is recommended from time to time or when you are seeing discrepancies, to refresh your Outlook windows. Do this by:

1. From the Send/Receive Tab, in the Send & Receive group, select Send Receive All Folders.
2. This will refresh all folders and views for Outlook.

**Using Majordomo Lists**

Majordomo lists are not recommended when creating meeting invites. To avoid problems, create a Contact Group (previously known as a distribution list) in Outlook. It is a way to group e-mail addresses collected under one name.

A message sent to a Contact Group goes to all recipients listed in the group. You can include Contact Groups in messages, task requests, meeting requests, and in other Contact Groups.
The maximum number of names that can be included in a Contact Group depends on the size of the contact file (for each contact) themselves. In general, a Group can contain between 50-70 names and email addresses. A maximum number of email addresses, with minimum contact file size is approximately 125, and this can include other Contact Groups.

**Create a Contact Group with new names or names in the Address Book**

1. From the Home tab, in the New group, select the dropdown menu arrow on New Items. From the submenu select More Items, then Contact Group.

![Create Contact Group](image1.png)

2. The Contact Group window displays.

![Contact Group Window](image2.png)

3. In the Name box, type a name for the Contact Group.
4. From the Contact Group tab, use the dropdown menu arrow on the Add Members command, and select From Outlook Contacts, From Address Book or New Email Contact.
5. Do this for each person whom you want to add to the Contact Group, and then select OK.
The Contact Group is saved in your Contacts folder under the name that you gave it.

Create a Contact Group by copying names from an email message

1. In the message that you want to copy the names from, highlight select the names in the To or Cc box.
2. Right-click your selection and select Copy.
3. Next, follow steps 1 – 3 above.
4. On the Contact Group tab, in the Members group, select the dropdown arrow on Add Members, and select either From Outlook Contacts or From Address Book.
5. At the bottom of the Select Members dialog box that displays, in the Members field, right-click and select Paste.

NOTE: A member doesn’t have to be in your Address Book to be added to the Contact Group. The member's name and email address are included when you copy and paste from the original email message.

Add a Contact Group received from someone

When you receive a message that includes a Contact Group that you want to use, it can be saved to your Contacts.

1. Open the message that contains the Contact Group.
2. In the To or Cc box, right-click the Contact Group, and then click Add to Outlook Contacts.

Add or delete a name in a Contact Group

In Contacts, open the Contact Group.

NOTE: In list views, Contact Groups are marked with the Contact Group icon.

Do one or more of the following:

- **Add an address from an address book or a contacts folder**
  1. On the Contact Group tab, in the Members group, select Add Members, then select From Outlook Contacts or From Address Book.
  2. In the Address Book drop-down list, select the address book that contains the email addresses that you want in your Contact Group.
  3. Browse for the name you want, or type it in the Search box.
  4. In the Name list, select the name, and then click Members. Do this for each person whom you want to add to the Contact Group, and then select OK.

- **Add an address that is not in a contacts folder or an address book**
  1. On the Contact Group tab, in the Members group, click Add Members, and then select New E-mail Contact.
  2. Type the information for the email address, and then select OK.
• Remove a name
  1. In the list of names, select the name that you want to remove, and then from the Contact Group tab, in the Members group, click Remove Member command.

How to access a majordomo lists recipients to add to a Contact Group

As the owner of a majordomo list you can access the list of recipients from the list and add them to a Contact Group.

NOTE: To find out who the list owner is contact the IT Help Center at x1400.

As the list owner, to access the listing of recipients and add them to a Contact Group:

1. Go to: www.csun.edu/majordomo
2. Select the Editing an existing distribution list link on the Majordomo Web page.
3. **Enter the name of the Email Distribution List**, (do not enter the @csun.edu) and the **List Password**, then select the **Edit** button.

```
Make a new distribution list
Edit an existing distribution list
Delete an existing distribution list
```

4. The list of recipients displays.

```
+-----------------------------+
| Name                      |
+-----------------------------+
| Joe Smith                 |
| John Doe                  |
| Sarah Jones               |
+-----------------------------+
```

5. Highlight the list of names, right-click and select **Copy**.

6. From **Contacts in Outlook**, from the **Home** tab, **New** group, select **New Contact Group** command icon.
7. The Contact Group dialog box displays.

8. In the **Name** field, enter the name of the group.

9. Select the **Add Members** command button from the **Contact Group** tab and select **From Address Book**. The **Select Members: Global Address List** dialog box appears.

10. In the Members field (at bottom) right-click and paste. The majordomo list of recipient’s names will paste into the field.

11. Select the **OK** button. The Contact Group dialog box displays with the list of names.

Your contact group is now set up in Outlook to use. **Remember**, that if the majordomo list is updated, that your Outlook group does not update automatically. Your will need to update it yourself.
HOW CALENDAR INFORMATION MAY BE REMOVED OR BECOME INACCURATE

There are several known scenarios that may occur in which calendar information may disappear, be removed or be inaccurate when using Outlook or Outlook Web Access. This section describes these scenarios.

*Forwarded meetings can lead to inaccurate information in the calendar*

I. Forward request as the meeting organizer

   The meeting organizer should not forward meeting requests. Consider the following scenario:
   1. If as the meeting organizer, you forward a meeting request to a recipient not in the original attendee list.
   2. Because the meeting was forwarded and the recipient was not added as an attendee, the recipient does not automatically get added to the attendee list.
   3. As meeting organizer, you change the time and send an update to the attendees.
   4. The recipient who received the forwarded meeting request does not receive the update.

   To include a new meeting attendee in an existing meeting request, the organizer should add the name to the meeting attendee list and send an update to the original meeting.

II. Forward request as a meeting attendee

   When you forward a meeting (recurring or single-instance) to a new attendee, the new attendee is not added to the original meeting unless the attendee sends a meeting response. All updates to the meeting are not sent to the attendee, resulting in out-of-date information in that attendee’s calendar.

*Send Update when changing a meeting as the meeting organizer*

When meetings that you organize are changed, you must click **Send Update** to make sure that the changes are sent to everyone that you invited to the meeting.

To send an update, follow these steps:

   1. In Outlook, open the meeting you organized.
   2. Change the meeting time, date or details.
   3. Click **Send Update** to send an updated meeting request to the invitees notifying them of the changes.

**NOTE:** 1) After you change a recurring meeting, wait at least five minutes before making other changes to allow for synchronization across all invitees. 2) Outlook allows a total of 123 revisions to a recurring meeting, so keep recurring meetings to 3 – 6 months maximum.
Process a meeting request in the Inbox

It is recommend and best practice to always accept or decline a meeting request from the Inbox. If you accept or decline a meeting by using the meeting item in the Calendar in Outlook, the meeting request remains in the Inbox. If you do not process the meeting request in the Inbox, the following issues may occur:

- You may be confused when you see this request later.
- If you appointed a delegate, the delegate may not know if you accepted the meeting request.
- If the organizer updates the meeting, the original meeting item in your Calendar may not be updated because the original meeting request was not processed.

**NOTE:** If you do not process meeting requests that are related to the same meeting in the order that they are received, the meeting item in your Calendar may be incorrect.

Use “Remove from Calendar”

Instead of deleting meeting cancellations from your inbox, click the **Remove from Calendar** button. Deleting the meeting cancellation from your inbox will not remove the meeting from your calendar.

**Personal notes are lost after a meeting update is received**

It is recommended that you do not take personal notes in the body of a meeting item in the calendar. If you are an attendee, your notes will be lost if a meeting update is received. If you are the organizer, your personal notes will be sent to everyone on the attendee list.

**TIPS FOR POWER USERS**

Let Outlook fill in your date for you

Outlook is smart. Here is a fun tip when creating an appointment or meeting request.

Instead of entering dates in the start and end time field

1. Type things like "Next Thursday" or “Two weeks from now” and press Enter.
2. Outlook will automatically fill in the date. Go on—try it! Pretty neat. This also works for recognized holidays with fixed dates every year such as Christmas, Halloween, and Saint Patrick’s Day etc. However, if you know that your holiday is the "last Thursday in November" (Thanksgiving) or the "second Monday in October" (Columbus Day), type that description in the box and Outlook will retrieve it.
Display a second time zone in your calendar

If you schedule meetings with people out of your time zone, this feature is very helpful. Display a second time zone in your calendar by following these few steps:

1. In Outlook 2010, from the **File** tab, select **Options** and then **Calendar**.
2. Under **Time zones** select **Show a second time zone**, give it a label such as Eastern, and then choose your second time zone from the dropdown menu.

![Time Zones Image]

The discovery: Back in the calendar, you'll see that two time zones are listed there and if you need to create a meeting or if you wonder why your contacts in back east haven't been responding to your frantic afternoon email messages, well, you'll see that it may be closing time for them.

Date in the future? Stop browsing and just GO THERE

You're in the calendar. Maybe you're in Week View or even Day View and you need to quickly jump to April 19, 2013. So do you change your view to Month View and start pushing those arrows to scroll through the months until you get to that date? No.

Simply press **CTRL+G** and type in the date in the date field. From there you can also choose how you want Outlook to display that date: In the Day, Week, Month, or Work Week Calendar.
MOBILE DEVICE TIPS

Inconsistent Synchronization

Two possible things to do to correct inconsistent synchronization in mobile devices:

1. Update your mobile devices OS.
   - Make sure that you are running the most recent OS for your device.

2. Do a hard restart of your device. Remove the battery, wait a few seconds then replace it. This resets the device and forces it to refresh.

TRAINING AND SUPPORT

IT Training

IT Training & Development
Phone: (818) 677-1700 or x1700 (on campus)
Email: training@csun.edu

NEED HELP?

Contact the IT Help Center by phone (818-677-1400), online at (http://techsupport.csun.edu) or in person in (Oviatt Library, Room 33).